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SYSTEM FOR COLLECTING,
TRANSFORMING AND MANAGING MEDIA
METADATA

FIELD OF THE INVENTION

This mvention relates to electronic data storage, content
management and retrieval systems and more particularly to
methods and apparatus for storing metadata describing mul-
fimedia data 1 a standardized format.

BACKGROUND OF THE INVENTION

Digital multimedia 1s stored 1n a variety of formats that
are very different from alphanumeric data. While textual
information supports the concepts of alphabetical ordering,
indexing, and searching, media data does not. Multimedia
formats are typically designed to fulfill playback rather than
manageability requirements. In order to add manageability,
1t 1s common to associate text-based descriptive “metadata”
or “annotations” with the media content.

In some cases, annotations can be automatically extracted
from the media. Examples include time-based samples of
audio or video presentations, and reduced-sized thumbnail
views of 1mage data. Many popular media formats, such as
QuickTime™ from Apple Computer and Advanced Stream-
ing Format (ASF) from Microsoft Corp., are designed to
capture and store a user’s text descriptions as well as system
annotations, and such metadata 1s generally added during
media creation and editing. In addition, emerging standards
such as Digital Versatile Disc (DVD) and MPEG-7 support
even richer metadata which facilitates the design of auto-
mated media management solutions. However, there 1s no
unified way of capturing and using this metadata in appli-
cation programs. Instead, special-purpose routines must be
written by the application programmer to handle each of the
wide variety of metadata storage techniques used by differ-
ent proprietary media formats.

SUMMARY OF THE INVENTION

The present invention may be employed to capture meta-
data stored 1n diverse proprietary formats, as well to capture
user-generated metadata and metadata from other sources,
and to transform the captured metadata into logical annota-
tions stored 1n a standard format. The standardized metadata
allows the described digital media to be more readily
managed, indexed, and searched by application programs
without special programming.

In the specific embodiment of the invention described
below, a media-speciiic metadata extracting component 1s
used to extract metadata already stored in the media file
according to the file format specifications for that particular
media type. A sample extraction program program 1s also
executed to analyze the media file to generate additional
information, such as time-based file samples, which char-
acterize the content of the file. In addition, a further routine
may be executed to acquire auxiliary data from one or more
sources external to the media file being described, including
such sources as the Internet or keyboarded descriptions
entered by the user.

As contemplated by the invention, after the metadata
describing the media file 1s obtained, it 1s combined to form
a set of logical annotations to the file. If desired, the resulting
logical annotations may be selectively organized into sum-
mary data which may be added to the original logical
annotations. The resulting logical annotations are then
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2

placed 1n a standard data representation, preferably extended
Markup Language (XML). These annotations may then be
stored, along with the original media, in a database adapted
for storing XML data. The metadata which 1s stored 1n the
database 1n this fashion may then be accessed by application
programs 1n standard ways to perform data management,
scarch, retrieval and playback functions.

These and other objects, features and advantages of the
present 1nvention may be better understood by considering
the following detailed description of the preferred embodi-
ment of the invention. In the course of this description,
reference will frequently be made to the attached drawings.

BRIEF DESCRIPTION OF THE DRAWINGS

FIG. 1 1s a block diagram 1llustrating the principle func-
tional components used to implement the preferred embodi-
ment of the invention;

FIG. 2 1s a pictorial view of graphical user interface
window which 1s displayed by a client computer to enable a
user to 1ntiate and control program functions and to provide
and edit annotation data; and

FIG. 3 1s a pictorial view of a sample data viewing pane
which 1s displayed in one portion of the window shown in

FIG. 2.
DETAILED DESCRIPTION

In the description of a specific embodiment of the mnven-
tion that follows, the term “media data™ includes both digital
video and audio data, and 1s to be distinguished from
text-based data which may be readily indexed and managed
by known techniques. Data which describes media data are
interchangeably referred to as “metadata” and
“annotations,” these terms being used interchangeably to
identify a collection of easily indexable and/or manipulable
attributes or properties which are typically expressed 1n
natural language text (such at media title, descriptors, copy-
right notices, and the like), and additional information such
as time based-samples of the content of the media data being

described.

The present invention provides a framework which may
be used to advantage to capture, transform, process, and
store metadata. This framework 1s extensible to allow for
user-defined components to be plugeed 1n at every step.

As shown 1n FIG. 1, media data flows through the system
along multiple paths. A metadata extractor 111 parses the file
of media data 113 to extract metadata embedded within the
file 113. A sample extractor 115 generates additional
information, such as time-based samples, from the content
of the media file 113. A transformer module 116 combines
the information generated by the metadata extractor 111 and
the processor 115 with additional metadata obtained from
sources external to the media files being processed. This
external data 1s gathered by an auxiliary processing step seen
at 117 1n FIG. 1. The transformer module 116 provides the
resulting collected metadata to a formatter 119. At this stage,
a summary of the media data can also be generated based on
the information captured so far as indicated by the summary
ogenerator seen at 121 1n FIG. 1. The formatter 119 converts
the collected and generated metadata, including any sum-
mary data from the generator 121, into a standard data
format, preferably the eXtended Markup Language (XML),
which may then be mapped at 123 into a corresponding
database schema and uploaded into the database shown at

125.

The system shown 1n FIG. 1 operates under the control of
a client computer indicated at 130 in FIG. 1. The client
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computer may be used to designate a media file to be
processed by supplying the media file’s filename 1n a file
system or i1ts Internet URL. The client computer 130 may
also be used to 1dentify or accept auxiliary metadata which
describes the media file being processed, the auxiliary data
being accepted as a user keyboard entry or by 1dentifying the
URL of Internet data which contains externally located
metadata which describes the media file 113 being pro-
cessed.

The mdividual components seen 1n FIG. 1 are described
in more detail in the following sections.
Client Interface

As shown 1n FIG. 1, the client computer 130 presents the
user mterface provided by the system. This user interface
may be a command line interface, a graphical interface of
the type 1llustrated 1in FIG. 2 to be discussed, or may take the
form of one or more Java servlets. A defined API may be also
used to expose the functionality of the system to client
programs which provide their own user interface.

An 1llustrative graphical user interface may employ a
windowed display as shown 1n FIG. 2 The GUI window
includes a menu bar seen at 210 which provides access to
five menus: File, Edit, Insert, Debug, and Help. The File
menu contains commands to open a media source file, open
an annotation, save an annotation, export an annotation as
XML, save the content of the console display (seen at 220),
and exit the program. The Edit menu contains commands to
delete a selected attribute from an extracted annotation, open
a preferences window, and save changes to the user-selected
preferences. Preferences can include database identification
and log-in mmformation to simplify the process of inserting
annotations and media data mto a selected database after
processing. The Insert menu which 1s accessed from the
Menu bar 210 contains a command to msert a new attribute
and attribute value into the current annotation. The Debug
menu contains a command to show the Debug Output Mode
window, and the Help menu provides access to instructions
and information 1n a help system to assist the user of the
program.

The GUI window pictured in FIG. 2 includes a toolbar at
230 which contains four buttons: Parse Media, Extract
Samples, Playback Media, and Send to Database. The Parse
Media button parses the media file which 1s currently
pomted to by the URL specified in the URL bar 225.
Pressing (clicking on) the Extract Samples button extracts
media samples from the media source file using the content
processor seen at 115 1n FIG. 1. Pressing the Playback Media
button plays the selected media file or extracted sample
using an associated “helper” application (typically regis-
tered with the operating system for playing media files of a
particular mimetype). The Send to Database button starts a
routine which guides the user through the process of map-
ping the annotations into a selected database schema and
uploading the media file and 1ts associated XML annotations
into the selected database. Before annotations can be
uploaded 1nto the database, tables are typically created in
accordance with a schema which corresponds to the ele-
ments of the XML annotation data which will be used to
access and manage the media. In most relational database
systems, the needed database tables may typically be created
using SQL Create Table statements which specily the
schema to be used.

The GUI window as seen 1n FIG. 2 further includes a URL
bar at 225 which contains two pieces of information: the
protocol used to parse the media source (such as “file,”
“http” or “cd”) and the location of the media source to be
parsed. Note that the URL used to locate audio CDs from a
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CD media source 1s not a standard URL but rather uses a
special syntax which permits the program to access data on
a CD drive through the operating system. For example,

using the Sun Solaris OS, the URL entered for a CD takes
the form “cd:/vol/dev/aliases/cdromO#cdda” whereas, under
Windows NT, it would have the form cd:[Windows
CD-ROM drive J#cdda”

The Annotations pane at 230 shows the URL protocol and
name of the source media file described by the current
annotation. This pane also contains an expandable list con-
taining the hierarchy of annotations and sub-annotations.
The types of the annotations and sub-annotations are shown
in the Annotations pane.

The GUI window depicted in FIG. 2 includes two tab-
selected panes for displaying and editing attributes and
samples. The pane selected by clicking on the Attributes tab
at 242 shows the attributes of the annotation that have
values, along with their values. The user can add attributes
to the extracted annotation or change the attribute values.
The Samples tab at 244 selects a samples display pane (seen
in FIG. 3 but not shown on FIG. 2) which displays the text
of a text sample laid out on a timeline.

The console panel shown at 220 mm FIG. 2 displays
messages pertaining to the status of the program’s opera-
tions. If an error occurs, notification 1s printed to the console
window, along with notification of any action that 1s taken
by the program. The console list can be saved to a file, as
noted above, using the File menu in the Menu bar at 210.

A status bar seen at 260 contains a field that tracks how
much of an operation is completed, from 0% to 100%.
Metadata Extraction

The metadata extractor seen at 111 in FIG. 1 extracts
metadata embedded 1n the digital media according to the file
format specifications for the particular type of media file 113
being processed. The type-specific file format specifications
define the structure of the file and indicate where metadata
of interest 1s located within the file, allowing it to be
extracted by the metadata extractor 111 and passed to the
transformer 116. The mimetype of the media source
(typically indicated by its filename extension) may be used
to dynamically load and execute an appropriate, type-
specific metadata extraction module adapted to extract
desired metadata from media files of the identified mime-
type. A set of standard metadata extraction modules for use
with widely used media types may be extensibly augmented
by additional, user-defined metadata extractors which may
be “plugged 1nto” the framework at run-time, thereby
extending the range of media formats handled by the system.

The metadata extractor 111 creates sub-annotations for
different parts of the media being processed. When, for
example, the metadata extractor 111 processes a CD con-
taining a movie, the extractor creates three separate logical
annotations: a video annotation, an audio annotation and a
text annotation. These annotations appear 1n a hierarchical
listing on the annotation pane 230 seen 1n FIG. 2 as follows:

CD Movie File Identification
Movie__Annotation
Video__Annotation
Audio__Annotation
Text__Annotation
Sample Extractor
The sample extraction program 115 1s responsible for
generating additional information by analyzing the actual
media content. The output of this engine 1s often a set of
time-based. samples as 1llustrated by the text samples seen
on the samples pane in FIG. 3. Examples of content descrip-
tive metadata created by the processing engine 115 include
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closed-captioning text, thumbnail 1images, embedded links
(URL flipping), and sample video and audio “clips.” Col-
lectively this information can be viewed as a set of time-
based snapshots of the media. Consequently, advanced que-
ries can be performed, producing results with time stamps
which can then be used to seek to specific positions within
the media. The samples pane 244 in the GUI interface
window permits the text based samples, which are displayed
along a time base which indicates their timed position within
the media presentation, may also be entered and edited by
the user during auxiliary processing as next discussed.
Auxiliary Metadata Processing,

Auxiliary metadata sources provide the information
which 1s not obtainable by processing the media itself. For
example, audio compact discs do not carry any meta-
information along with the physical media; it 1s therefore
necessary to gather metadata from auxiliary sources such as
user’s 1nput, or from look-up services available on the
Internet. The 1mvention facilitates this data gathering func-
fion by establishing predetermined, standardized metadata
content which 1s gathered during the auxiliary processing
step mdicated at 117, as discussed later.

Transformation

The transformer 116 combines the media information
collected thus far to construct unified logical annotations
which contain attribute value pairs, as well as time-based

Predefined Annotations

Attribute Description
Media Annotation
MA_ TITLE Title of the media

MA__COPYRIGHT

MA_ PRODUCER

MA_ DURAITTON
MA__CONTENT_DAIE
MA__ MODIFICATTION__ TIME
MA_ CREDITS

MA_ SIZE

MA_ FORMAT__ENCODING
MA__USER__DATA

MA__ LANGUAGE

Producer of the media

Size of the media
Format of the media

Language of the media
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6

samples, describing the media. For example, the logical
annotation for an audio compact disc will feature attributes
such as the title, artist, duration, and number of tracks as well
as audio clips for each track. The primary task performed by
the transformer 116 1s organizing the set of captured
attributes and partitioning them semantically into such pre-
determined logical annotations.

This structuring of the metadata provides a facilitated
method of managing the media. In particular, the effect of
such a transformation 1s an abstraction layer above the
diverse multitude of media formats. The client of annota-
tions 1s shielded from having to understand the format and
storage specifications of the original media source. It 1s thus

becomes possible to manage the data in a semantically rich
manner. The system provides a predefined set of

annotations, but these annotations can be overridden or
replaced with a completely new set. Similar to manner in
which type-specific metadata extractors are loaded and
executed, annotations are dynamically loaded based upon
the mimetype of the media being processed.

The predefined set of media annotations are listed below.
Each consists of a value pair consisting of an attribute
identifier and a value. In the list below, each 1dentifier is
listed along with a description of the value data that is
assoclated with each identifier.

Copyright information of the media

Duration (in seconds) of the media
Creation date of the media content
Modification time of type Java.lang.Date
Credits for content providers

MA_ BITRATE Bitrate of the media (in bits/second)
MA__ CATEGORY Media category/genre

MA_ SOURCE__URL Location/URL of the parsed media source
MA_ SOURCE__ PROTOCOL URL protocol of the media source

MA__ SOURCE_MIME_ TYPE MIME type of the media and its samples
MA__ SOURCE__ DIRECTORY Directory where the source 1s stored
MA_ SOURCE__FILENAME Filename of the source

MA__ SOURCE__FILE__ FORMAT Media file format

MA_AUTHORTNG_TOOL
Audio Annotation

Software tool used to create the media

AA__AUDIO__ARTIST Main artist for the audio clip
AA__AUDIO__BITS__PER_SAMPLE Number of bits per sample
AA_AUDIO_SAMPLE__RATE Audio sample rate (in samples/second)
AA__AUDIO_NUM__CHANNELS Number of audio channels

Video Annotation
VA__VIDEO__FRAME__RATE Video frame rate (in frames/second)
VA__VIDEO__FRAME_SIZE Video frame size (in bytes)
VA__VIDEO__SRC_HEIGHT Video height (in pixels)
VA_VIDEO_ SRC_WIDTH Video width (in pixels)
VA__VIDEO__HORIZONTAL_ RES Horizontal resolution (in pixels/inch)

VA_VIDEO VERTICAIL RES
VA_VIDEO_ IS GRAYSCALE
VA__VIDEO_DEPTH

Text Annotation

TA_TEXT__SIZE

Point size of the text track

Vertical resolution (in pixels/inch)
Whether the video has colors
Number of bits for the color depth
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Attribute

TA_TEXT_ _BG_COLOR
TA_TEXT_ FG_COLOR
ALIGN

TA__TEXT

TA_TEXT_ FONTNAME
TA_TEXT_ FONTFACE
TA_TEXT_ DEF__BOX

MVA__MOVIE_ DIRECTOR
MVA__MOVIE__CAST

ACDA_AUDIO_ (]
ACDA_AUDIO_ (]
ACDA__AUDIO_ (]
ACDTA_AUDIO_CD_TRACK__CDID
ACDTA__AUDIO_CD_TRACK__ALBUM
ACDTA_TRACK__ID
ACDTA_AUDIO__ (]
ACDTA__AUDIO__(C]
ACDTA_AUDIO__(C]
ACDTA__START__FRAME

Not all media files will provide values for every attribute
in the predefined set. However, the user can use employ the
GUI window seen 1n FIG. 2 to add a value to an annotation
for any attribute that does not have a value, or to edit a value
already present.

Note that the program cannot write any new attribute
values back to the media files. The current annotation will
contain the value, but any annotations created later will not
contain the new value. To add a value for an attribute that has
not been automatically set during metadata extraction or
during the operation of the content processor 115, the user
need only perform the following operations during auxiliary

processing (step 117 in the FIG. 1):

1. From the Insert menu, select Attribute. A blank table
row will appear in the Annotations tab.

2. Click the left-hand table cell of the new row. A pop-up
menu will appears. This window contains the names of
all attributes that do not have values.

3. Select an attribute from the pop-up menu.

4. Enter a value 1n the right-hand table cell.
Summary Generator

Logical annotations can be processed to generate a sum-
mary of the media. The summary generator 121 accom-
plishes this task according to user’s speciiied guidelines. For
example, a song can be summarized by grouping together
previously extracted or collected metadata, such as the
performer’s name, the song ftitle, and a song clip. Such
summaries are especially usetul for quick browsing of media
catalogs.
Formatter

The formatter 119 1s responsible for transforming the
logical annotations as well as the summaries 1nto a form
which 1s searchable and manageable by databases. A well-
defined XML structure 1s used to store this information,
hence a unified representation for the metadata 1s achieved.
Database Mapper

Database mapping constitutes the final step of the trans-
formation chain and finally completes the database popula-
fion process. During this step, seen at 123 in FIG. 1, the
system uploads the media and the associated XML
document, produced by the formatter 119, into a database
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D ARTIST
D__NUM__ OF__TRACKS
D_ID

-continued

Predefined Annotations

Description

Background color (0x0000RRRRGGGGBBBB)
Foreground color (0xO000RRRRGGGGBBBB)
Left, center, right, or justified
Name of the font used
Font styles used (such as italics or boldface)
Default text box size

Movie Annotation

Director of the movie
Names of the performers in the movie

Audio CD Annotation

Main artist of the CD
Number of tracks on the CD
CD identifier

CD identifier (in track sub__annotation)
Audio CD title

Track 1dentifier within the audio CD
Logical block address of the track
Starting minute of the track

D__TRACK_LBA
D__TRACK_MINUTE

D__TRACK_SECOND  Starting second of the track

Starting frame of the track

which supports the storage of data expressed mm XML.
Preferably, the media file 1tself 1s also stored along with the
metadata 1n the same database. By way of example, the
Oracle 81™ database available from Oracle Corporation,
Redwood Shores, Calif., and the media support offered by
Oracle mnterMedia™, allows for stmultaneous storage of the
actual media data and its corresponding metadata. See
“Oracle8i interMedia Audio, Image, and Video User’s

Guide and Reference.” Release 8.1.,5 Oracle Corporation
(A67299-01), 1999.

The database mapper 123 maps the elements of the XML
“documents” which contain the logical annotation metadata
into the corresponding schema used by the database for
storing, indexing, searching and managing the media and its
metadata. The physical properties captured mm a logical
annotation are mapped mto the fields of a database object. In
addition, the XML representation, which includes content
attributes obtained by the content processor 115, may also
stored within the database object. In addition to allowing the
media source file to be stored with the metadata, a pointer to
(the URL of) the media resource may be stored instead when
it does not make sense for the whole media source to be
stored. As a result, a self-contained repository, for the media
data and 1its description, 1s created in the database. This
repository can now be indexed with conventional indexing
techniques, enabling advanced searches on the multimedia
data.

Media Playback

The program operated from the GUI interface seen 1n
FIG. 2 1s also capable of playing media source {files and
extracted media samples. However, 1in order to play such
files, the user may need to install some helper applications
for playing the desired media type. Typical helper applica-
tions for the Windows environment include the Microsoft
Windows Media Player, the QuickTime 4.0 for Windows
from Apple Computer, RealPlayer from RealNetworks, Inc.
and WinAmp from Nullsoft, Inc. Helper applications which
operate 1n the Sun Solaris environment are the Java Media
Framework (JMF) player and XAnim (freeware available
from Mark Podlipec, 15 Meadow Lane, Shrewsbury Mass.
01545 USA).

Conclusion
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It 1s to be understood that the specific embodiment of the
invention which has been described 1s merely illustrative of
one application of the principles of the invention. Numerous
modifications may be made to the system described without
departing from the true spirit and scope of the invention.

What 1s claimed 1s:

1. The method for storing multimedia data comprising, in
combination, the steps of:

determining the particular media type of a file of data to
be stored,

selecting and executing a metadata extracting program to
extract metadata stored 1n said file of data 1n accor-
dance with the file format specifications for said par-
ticular media type,

selecting and executing a sample extraction program for
analyzing the content of said file of data to generate
additional i1nformation characterizing the content of

said file,

selecting and executing a program for acquiring auxiliary
data characterizing said file of data from one or more
sources other than said file of data,

combining said metadata, said additional information and
said auxiliary data for form a set of logical annotations
to said file of data,

formatting said logical annotations into a standard data
representation, and

storing the combination of said file of data and logical

annotations 1n a database.

2. The method set forth 1n claim 1 wherein said additional
information generated by said sample extraction program
includes time-based samples of said file of data.

3. The method set forth m claim 1 wherein one of said
sources of auxiliary data include data provide by user
characterizing said file of data.

4. The method set forth 1n claim 1 wherein said standard
data representation 1s the eXtended Markup Language.

5. The method set forth m claim 1 including the further
step of processing said logical annotations to produce sum-
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mary data which 1s combined with said logical annotations
and formatted 1nto said standard data representation.

6. Apparatus for collecting and storing metadata describ-
ing a plurality of media data files of different types having
different format specifications comprising, 1n combination,

means for extracting imbedded metadata from each of
sald media data files,

means for processing the content of each of said media
data files to produce 1nformation representing said
content,

means for accepting external data describing at least
selected ones of said files from sources other than said
selected ones of said data files,

means for combining said 1mbedded data, said informa-
tion representing said content, and said external data to
form logical annotation data associated with each of
said media data files, and

means for storing said logical annotation data in a stan-

dard data format.

7. Apparatus as set forth 1n claim 6 wherein said infor-
mation representing said content includes one or more
fime-based samples of the content of at least some of said
media files.

8. Apparatus as set forth 1n claim 7 further including
means for processing said logical annotation data to produce
summary data which 1s stored with said logical annotation
data 1n said standard data format.

9. Apparatus as set forth 1n claim 6, wherein said standard

data format 1s the eXtensible Markup Language.

10. Apparatus as set forth in claim 6, wherein said means
for storing said logical annotation data 1n a standard data
format 1mncludes means for mapping at least a portion of said
annotation data mto a database schema and uploading said
portion of said annotation data into a database in accordance
with said schema.
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